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Introduction 
Introduction

This workbook is designed to help you practice the skills associated 
with SUSE Linux Enterprise Server 10 Fundamentals (Course 
3071) objectives.

These skills, along with those taught in the SUSE Linux Enterprise 
Server 10 Administration (3072) and SUSE Linux Enterprise Server 
10 Advanced Administration (3073) courses, prepare you to take the 
Novell Certified Linux Professional 10 (Novell CLP 10) 
certification practicum test.

x Instructions for setting up a self-study environment are in the directory setup 
on the Course DVD.

Before starting the exercises in this workbook, you need to review 
the following:

■ Course Scenario

■ Exercise Conventions
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Course Scenario

You are system administrator for your Digital Airlines office. The 
management is considering migration of some network services to 
SUSE Linux Enterprise Server 10 servers.

As system administrator, you decide to do the following: 

■ Install SUSE Linux Enterprise Server 10 on a test workstation. 

■ Become familiar with the graphical user interface and the 
command line interface. 

■ Learn how to integrate your SUSE Linux Enterprise Server into 
an existing network.

■ Learn how to get help for all problems you might have.

■ Learn how to manage software packages with the configuration 
tool YaST2.

■ Learn how to edit configuration files with an graphical editor or 
the command line editor vi. 

■ Understand the structure of the Linux file system and basic 
shell commands for working in the file system (e.g. copying, 
moving). 

■ Learn how to manage users, groups and file permissions to 
ensure a basic file system security.

Once you complete this training, you will be able to install SUSE 
Linux Enterprise Server 10 and set up a system for further tests. 
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Introduction 
Exercise Conventions

When working through an exercise, you will see conventions that 
indicate information you need to enter that is specific to your server.

The following describes the most common conventions:

■ italicized/bolded text. This is a reference to your unique 
situation, such as the host name of your server.

For example, if the host name of your server is DA50, and you 
see the following,

hostname.digitalairlines.com

you would enter

DA50.digitalairlines.com

■ 10.0.0.xx. This is the IP address that is assigned to your SUSE 
Linux Enterprise Server 10 server.

For example, if your IP address is 10.0.0.50, and you see the 
following

10.0.0.xx

you would enter

10.0.0.50

■ Select. The word select is used in exercise steps to indicate a 
variety of actions including clicking a button on the interface 
and selecting a menu item.

■ Enter and Type. The words enter and type have distinct 
meanings.

The word enter means to type text in a field or at a command 
line and press the Enter key when necessary. The word type 
means to type text without pressing the Enter key.

If you are directed to type a value, make sure you do not press 
the Enter key or you might activate a process that you are not 
ready to start.
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Understand the Linux Story 
S E C T I O N 1 Understand the Linux Story

In this section of the workbook, you learn how to do the following:

■ “Install SUSE Linux Enterprise Server 10” on 1-2

In this exercise, you install SUSE Linux Enterprise Server 10.
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Exercise 1-1 Install SUSE Linux Enterprise Server 10

In this exercise, you install SUSE Linux Enterprise Server 10. 
Select the default options when possible.

In part III, enter digitalairlines.com as domain name. In part IV, 
use novell as root password. In part V, deactivate the firewall and 
skip the Novell Customer Center configuration. In part VI, create an 
user account geeko for Geeko Chameleon with password of novell.

Do the following:

■ Part I: Boot the System and Start the Installation

■ Part II: Check your Keyboard Layout before Starting the 
Installation of the Software Packages

■ Part III: Specify your Hostname

■ Part IV: Enter a Root Password

■ Part V: Open SSH Port and Test the Internet Connection

■ Part VI: Configure Basic Services

■ Part VII - Select Local User Authentication and Add a User

■ Part VIII: Finish the Installation

Part I: Boot the System and Start the Installation

To boot the system and start the installation, do the following:

1. Insert SUSE Linux Enterprise Server 10 DVD into your DVD 
drive.

2. Reboot your computer.

3. From the installation menu, select Installation and press Enter.

4. From the language dialog, select English (US); then select Next.

5. From the Novell Software License Agreement dialog, select Yes, 
I Agree to the Licence Agreement and then select Next.

6. (Conditional) Select New installation; then select Next.
WB 1-2 Copying all or part of this manual, or distributing such copies, is strictly prohibited.  Version 1
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Understand the Linux Story 
7. From the Clock and Time Zone dialog, select your region and 
time zone. Select Next.

Part II: Check your Keyboard Layout before Starting the 
Installation of the Software Packages

To check your keyboard layout before starting the installation of the 
software packages, do the following:

1. In the Overview tab verify that the correct keyboard layout is 
selected in the section Keyboard Layout.

2. (Conditional) If the correct keyboard layout is not selected, from 
the Change drop-down list select Keyboard Layout; then select 
the correct layout and select Accept. 

3. Confirm the YaST installation suggestions by selecting Accept.

4. Confirm the installation settings by selecting Install.

After copying files and finishing a basic installation, YaST 
reboots your computer to a Password for “root” dialog.

Part III: Specify your Hostname

To specify your hostname, do the following:

1. In the Domain Name field, enter digitalairlines.com. Make sure 
that the option Change Hostname via DHCP is activated. Select 
Next.

Part IV: Enter a Root Password

To enter a root password, do the following:

1. Specify the root password by entering novell (twice); then select 
Next.

2. Confirm the two warning messages by selecting Yes.
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x You should use an insecure password (such as novell) only for the 
purpose of training. Choose a more secure password on a live system.

Part V: Open SSH Port and Test the Internet Connection

To open the SSH port and test the internet connection, do the 
following:

1. To allow network access to your computer for your trainer, 
disable the Firewall by selecting enabled in the second line of the 
Firewall section (“Firewall is enabled” changes to “Firewall is 
disabled”). Confirm the other suggestions of YaST's network 
configuration by selecting Next.

2. Select Yes, Test Connection to the Internet; then test your 
Internet connection by selecting Next.

3. Do one of the following:

❑ If the connection test fails (you see a failed message for the 
release notes), select OK and then Next.

or

❑ If the connection test is successful, select Next.

4. In the Novell Customer Center select Configure Later; then 
select Next.

x You should install the updates on production systems. You do not install 
the updates during training because the updates might change menus 
and user interfaces. Also you need a maintenance contract with Novell 
to get updates for SUSE Linux Enterprise Server 10.

Part VI: Configure Basic Services

To configure basic services, do the following:

1. In the Service Configuration dialog, make sure that Use 
Following Configuration is selected; then select Next.
WB 1-4 Copying all or part of this manual, or distributing such copies, is strictly prohibited.  Version 1
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Understand the Linux Story 
Part VII - Select Local User Authentication and Add a User

1. In the User Authentication Method dialog, select Local 
(/etc/passwd); then select Next.

2. Add a local user by entering the following:

❑ User’s Full Name: Geeko Chameleon

❑ Username: geeko

❑ Password: novell

❑ Confirm Password: novell

When you finish, select Next.

3. Confirm the two warning messages by selecting Yes.

x You should use an insecure password (such as novell) only for the 
purpose of training. Choose a more secure password on a live system.

YaST begins configuring your SUSE Linux Enterprise Server 
10 system.

Part VIII: Finish the Installation

To finish the installation, do the following:

1. Confirm the release notes by selecting Next.

2. Accept the default hardware configuration by selecting Next.

3. Deselect the option Clone This System for Autoyast and select 
Finish.

The GUI login screen appears. 

(End of Exercise)
Version 1 Copying all or part of this manual, or distributing such copies, is strictly prohibited.  WB 1-5
To report suspected copying, please call 1-800-PIRATES.

ONLINE VIEW ONLY-NO PRINTING OR DISTRIBUTION ALLOWED



SUSE Linux Enterprise Server 10 Fundamentals / Workbook 
WB 1-6 Copying all or part of this manual, or distributing such copies, is strictly prohibited.  Version 1
To report suspected copying, please call 1-800-PIRATES.

ONLINE VIEW ONLY-NO PRINTING OR DISTRIBUTION ALLOWED



Use the Linux Desktop 
S E C T I O N 2 Use the Linux Desktop

In this section of the workbook, you learn how to do the following:

■ “Log In to and Log Out from the GNOME Desktop” on 2-2

In this exercise, you learn how to log in to and log out from 
your GNOME desktop.

■ “Work with Icons in GNOME” on 2-3

In this exercise, you add a new icon to your desktop. You also 
add and remove an applet to and from the bottom panel.

■ “Use the GNOME File Manager (Nautilus)” on 2-5

In this exercise, you explore your GNOME desktop and learn 
how to use the GNOME File Manager Nautilus.

■ “Access the Command Line Interface” on 2-8

In this exercise, you switch to virtual terminals and back to the 
graphical user interface. You also log in and log out at a virtual 
terminal.
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Exercise 2-1 Log In to and Log Out from the GNOME Desktop

In this exercise, you learn how to log in to and log out from your 
GNOME desktop. 

Do the following from the GUI login screen (where you were left 
after installing SUSE Linux Enterprise Server 10):

1. In the Username field, enter geeko; then press Enter.

2. In the Password field, enter novell; then press Enter.

For security reasons, asterisks are displayed instead of the 
letters when you are entering the password.

The GNOME desktop environment starts.

3. To log out, open the main menu (labeled Computer) in the 
bottom panel.

4. Select Log Out.

5. In the confirmation dialog, select OK.

You are returned to the GUI login screen.

(End of Exercise)
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Exercise 2-2 Work with Icons in GNOME

In part I of this exercise, you add a new launcher labeled “xeyes” 
for the program /usr/X11R6/bin/xeyes to your desktop. The icon for 
the new launcher should be gnome-eog.png. In part II, you add and 
remove the applet “geyes” to and from your bottom panel.

Do the following:

■ Part I: Create a new Launcher

■ Part II: Add and Remove an Applet to and from the Bottom 
Panel

Part I: Create a new Launcher

To create a new launcher, do the following:

1. Right-click the background of your desktop.

2. Select Create Launcher from the pop-up menu.

3. In the Name textbox enter
xeyes

4. In the Command textbox enter
/usr/X11R6/bin/xeyes

5. Select No Icon.

6. Select gnome-eog.png from the Browse Icon dialog.

7. Select OK.

8. Select OK.

Part II: Add and Remove an Applet to and from the Bottom 
Panel

To add and remove an applet to and and from the bottom panel, do 
the following.
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1. To add a new applet in the bottom panel, right-click at a free 
space in the bottom panel.

2. Select Add to Panel from the pop-up menu.

3. Select Geyes from the list and then select Add.

4. Move your mouse pointer.

5. To remove the Geyes applet, right-click the applet in the bottom 
panel.

6. Select Remove from Panel from the pop-up menu.

(End of Exercise)
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Exercise 2-3 Use the GNOME File Manager (Nautilus)

In this exercise, you explore your GNOME desktop. Use Nautilus to 
copy the file /etc/DIR_COLORS into your home directory and add 
the “Oh no!” emblem to the copied file. In part IV, you rename the 
copied file to “example.txt”. In part V, you delete example.txt and 
empty the trash.

Do the following:

■ Part I: Start GNOME

■ Part II: Start Nautilus and Copy a File

■ Part III: Add an Emblem to the Copied File Icon

■ Part IV: Rename the Copied File

■ Part V: Delete the Copied File

Part I: Start GNOME

To start GNOME, do the following:

1. In the Username field, enter geeko and press Enter.

2. In the Password field, enter novell and press Enter.

For security reasons, asterisks are displayed instead of the 
actual letters when you enter the password.

The GNOME desktop environment starts.

Part II: Start Nautilus and Copy a File

To start Nautilus and copy a file, do the following:

1. Start the Nautilus file manager by selecting the geeko’s Home 
icon on the desktop.

2. View the file system tree in the side panel by opening the menu 
at the top of the side panel (labeled Places when Nautilus is 
started the first time). Select Tree from the menu.
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3. View the contents of the /etc directory by selecting the small 
triangle in front of the File System entry in the side panel. Then 
select etc in the side panel (a single mouse click).

4. Copy the file /etc/DIR_COLORS on the desktop by scrolling 
down and selecting the DIR_COLORS file icon, dragging it 
over the desktop while the Ctrl key is pressed, and releasing the 
mouse button.

Notice there is a small plus at the mouse pointer while dragging 
the file, indicating that you are copying a file.

5. Switch back to your home directory by selecting Home Folder 
in the side panel.

6. Move the file DIR_COLORS from the desktop into your home 
directory by selecting the DIR_COLORS file icon, dragging it 
over the right frame of the Nautilus window, and releasing the 
mouse button.

Notice there is no small plus at the mouse pointer while 
dragging the file, indicating that you are moving a file.

Part III: Add an Emblem to the Copied File Icon

To add an emblem to the copied file icon, do the following:

1. Switch to the list of emblems by opening the menu at the top of 
the side panel (labeled Tree now). Select Emblems from the 
menu.

2. Scroll down in the side panel to the Oh no! icon.

3. Drag the Oh no! icon over the icon of the DIR_COLORS file in 
the right frame, and release the mouse button.

Part IV: Rename the Copied File

To rename the copied file, do the following:

1. Rename the copied file by right-clicking the DIR_COLORS file 
icon, and then selecting Rename from the popup menu.
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2. For the new filename, type example.txt; then press Enter.

Part V: Delete the Copied File

To delete the copied file, do the following:

1. Delete the file example.txt by dragging the file icon over the 
Trash icon on the desktop, and releasing the mouse button.

2. Close the Nautilus file manager window.

3. Right-click the Trash icon on the desktop and select Empty 
Trash from the pop-up menu.

4. In the confirmation dialog, select Empty Trash.

(End of Exercise)
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Exercise 2-4 Access the Command Line Interface

In this exercise, you log in as user geeko at the first virtual terminal. 
You switch to the second virtual terminal and verify that a login 
prompt is shown there. Before switching back to the graphical user 
interface, you log out from the first virtual terminal.

Do the following:

1. Switch to the first virtual terminal by pressing Ctrl+Alt+F1.

2. Type geeko as a login name and press Enter.

3. Type novell as the password and press Enter.

4. Switch to the second virtual terminal by pressing Ctrl+Alt+F2. 

Notice that you are not logged in at this terminal.

5. Press Ctrl+Alt+F1 to switch back to the first terminal.

You are still logged in as geeko.

6. Log out by entering:
exit

7. Switch back to the graphical user interface by pressing 
Ctrl+Alt+F7.

(End of Exercise)
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S E C T I O N 3 Administer Linux with YaST

In this section of the workbook, you learn how to do the following:

■ “Get to Know YaST” on 3-2

In this exercise, you learn how to use the different user 
interfaces of YaST and how to start some YaST modules.

■ “Manage the Network Configuration Information from YaST” 
on 3-5

In this exercise you change all the network configuration 
information into static values.

■ “Install New Software” on 3-9

In this exercise, you install another software package that is 
available on the SUSE Linux Enterprise Server 10 installation 
media. 
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Exercise 3-1 Get to Know YaST

In this exercise, you learn how to use the different user interfaces of 
YaST and how to start some YaST modules. In part I, you start the 
graphical user interface of YaST. In part II, you view the file 
/proc/version with the YaST system log module. In part III, you to 
set the time. Repeat part I and II with the ncurses user interface of 
YaST in part IV and V.

To use YaST, do the following:

■ Part I: Start YaST

■ Part II: View the Content of a System Log File

■ Part III: Change Time and Date

■ Part IV: Start the ncurses Interface of YaST

■ Part II: View the Content of a System Log File

■ Part VI: Exit YaST

Part I: Start YaST

To start YaST, do the following:

1. From the GNOME desktop, open the main menu.

2. Select More Applications.

3. Enter ya into the Filter text box.

4. Select the YaST icon to start YaST.

5. Enter the root password novell in the appearing dialog; then 
select Continue or press Enter.

The YaST Control Center appears.

Part II: View the Content of a System Log File

To view the content of a system log file, do the following:

1. Select Miscellaneous > View System Log.
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2. From the top drop-down list, select /proc/version.

3. Close the log window by selecting OK.

Part III: Change Time and Date

To change time and date, do the following:

1. Select System > Date and Time.

2. Select Change.

3. Enter the current time (such as 08:00:00) and the current date 
(such as 27/04/2006).

4. Select Apply.

5. Select Accept.

Part IV: Start the ncurses Interface of YaST

To start the ncurses interface of YaST, do the following:

1. Switch to the first virtual terminal by pressing Crtl+Alt+F1.

2. Log in as root with a password of novell.

3. View a list of the available YaST modules by entering yast -l.

4. Enter yast to start the ncurses interface of YaST.

Part V: View the Content of a System Log File

To view the content of a system log file, do the following:

1. Press cursor-down until Miscellaneous is highlighted in the left 
frame and press Enter.

2. Press cursor-down until View System Log is highlighted in the 
right frame and press Enter.

3. Press cursor-down until /proc/version is selected and press 
Enter.
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4. Press Tab twice to highlight OK and press Enter.

Part VI: Exit YaST

To exit YaST, do the following:

1. Press Alt+Q to select Quit.

2. Log out by entering
exit

3. Switch back to the graphical interface by pressing Crtl+Alt+F7.

4. Close the YaST window.

(End of Exercise)
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Exercise 3-2 Manage the Network Configuration Information from YaST

Up to now, your system got all network configuration information 
via DHCP. In this exercise you change all the important information 
into static values.

Use the ip command to find out which ip address you are currently 
using. Also note your current hostname. Then change the network 
configuration to static IP addresses, using the values you found. Use 
10.0.0.254 as default gateway and also as address of the name 
server.

To manage the network configuration information from YaST, do 
the following:

■ Part I: Get your IP Number and Hostname

■ Part II: Start the YaST Network Configuration Module

■ Part III: Enter a Static IP Address and Subnet Mask

■ Part IV: Change your Hostname

■ Part V: Enter a DNS Server

■ Part VI: Enter a Default Gateway

■ Part VII: Activate new Settings and Finish

Part I: Get your IP Number and Hostname

To get your IP number and hostname, do the following:

1. From the GNOME desktop, open the main menu.

2. Select More Applications.

3. Enter term into the Filter text box.

4. Select the Gnome Terminal icon to start a terminal emulation.

5. Enter /sbin/ip address show to record the following information 
for your SUSE Linux Enterprise Server 10 server:

❑ IP address:

❑ Hostname:
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6. Close the terminal window.

Part II: Start the YaST Network Configuration Module

To start the network configuration module of YaST, do the 
following:

1. From the GNOME desktop, open the main menu.

2. Select More Applications.

3. Enter ya into the Filter text box.

4. Select the YaST icon to start YaST.

5. Enter the root password novell in the appearing dialog; then 
select Continue or press Enter.

The YaST Control Center appears.

6. Start the network card module by selecting Network Devices > 
Network Card.

Part III: Enter a Static IP Address and Subnet Mask

To enter a static IP address and subnet mask, do the following:

1. Make sure that Traditional Method with ifup is selected and 
select Next.

Your network card is listed in the upper table.

2. Make sure your network card is selected; then select Edit.

3. Make sure that the Address tab is activated.

4. Switch the setup by selecting Static address setup.

5. In the IP Address field, enter the IP address from Part I.

6. In the Subnet mask field, enter 255.255.255.0.
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Part IV: Change your Hostname

To change your hostname, do the following:

1. Select Host name and name server.

2. (Conditional) If a dialog appears indicating that the resolv.conf 
files has been temporarily modified, continue by selecting 
Modify.

3. In the Hostname field, enter the hostname from Part I.

4. In the Domain Name field, enter digitalairlines.com.

Part V: Enter a DNS Server

To enter a DNS server, do the following:

1. In the Name Server 1 field, enter the IP address of your DNS 
server (10.0.0.254).

2. If there are values in the other Name Server text fields, remove 
them.

3. In the Domain Search field, enter digitalairlines.com.

4. If there are values in the other Domain Search text fields, remove 
them.

5. Select OK.

Part VI: Enter a Default Gateway

To enter a default gateway, do the following:

1. Select Routing.

2. In the Default Gateway field, enter the IP address of your Internet 
gateway (10.0.0.254).

3. Select OK.
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Part VII: Activate new Settings and Finish

To activate new settings and finish, do the following:

1. Select Next.

2. Select Next.

3. Close the YaST Control Center.

4. To test your network connection, start the web browser Firefox 
and try to call http://www.novell.com.

(End of Exercise)
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Exercise 3-3 Install New Software

In this exercise, you install another software package that is 
available on the SUSE Linux Enterprise Server 10 installation 
media. It is called locate and it is needed in one of the following 
sections. 

To install new software, do the following:

■ Part I: Start YaST

■ Part II: Look for a Software Package

■ Part II: Install a Software Package and Finish

Part I: Start YaST

To start YaST, do the following:

1. From the GNOME desktop, open the main menu.

2. Select More Applications.

3. Enter ya into the Filter text box.

4. Select the YaST icon to start YaST.

5. Enter the root password novell in the appearing dialog; then 
select Continue or press Enter.

6. The YaST Control Center appears.

Part II: Look for a Software Package

To look for a software package, do the following:

1. From the YaST Control Center, select Software > Software 
Management.

2. From the Filter drop-down list, select Search.

3. In the Search textbox enter locate; select Search.
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Part II: Install a Software Package and Finish

To install a software package and finish, do the following:

1. From the right side of the window, select the package 
findutils-locate.

2. Select Accept.

3. (Conditional) If requested by YaST, insert the appropriate SUSE 
Linux Enterprise Server 10 DVD; then select OK.

4. When asked to install or remove more packages, select No.

5. Close the YaST Control Center by selecting Close.

6. (Conditional) If you installed from DVD, remove the DVD from 
your drive.

(End of Exercise)
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S E C T I O N 4 Locate and Use Help Resources

In this section of the workbook, you learn how to do the following:

■ “Access and Use man Pages” on 4-2

In this exercise, you learn how to use the commands whatis and 
man and how to navigate in the help text.

■ “Access and Use info Pages” on 4-3

In this exercise, you learne how to use the info command and 
how to navigate in the info text. 

■ “Access Release Notes and White Papers Pages” on 4-4

In this exercise, you access release notes and white paper pages. 

■ “Find Help on the Web” on 4-7

In this exercise, you learn how to find help on the web.
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Exercise 4-1 Access and Use man Pages

In this exercise, you learn how to use the commands whatis and 
man and how to navigate in the help text. You find out how often 
the man pages of the info command contain the word “filename”. 

To get help about the command info, do the following:

1. From the GNOME desktop, open the main menu.

2. Select More Applications.

3. Enter term into the Filter text box.

4. Select the Gnome Terminal icon to start a terminal emulation.

5. Find the sections of the man pages for the command info by 
entering whatis info.

6. Read the first section (executable programs and shell commands) 
of the man pages of the command info by entering man 1 info.

7. To look for “filename”, enter /filename.

8. Scroll through the text with the up and down arrow keys.

9. When you finish viewing the information, exit (quit) the man 
page by typing q.

Leave the Terminal window open for the next exercise.

(End of Exercise)
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Exercise 4-2 Access and Use info Pages

In this exercise, you learn how to use the info command and how to 
navigate through the info text. 

To use info pages of the command info, do the following:

1. From the terminal window, display the info pages for the 
command info by entering info info.

2. Move the cursor to the first reference (Getting Started) by 
pressing Tab.

3. Follow the reference by pressing Enter.

4. Move the cursor to the reference Quitting Info by pressing Tab 
nine times.

5. Follow the reference by pressing Enter.

6. Return to the page Getting Started by typing l (lowercase L).

7. Exit the info file by typing q.

8. Close the terminal window.

(End of Exercise)
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Exercise 4-3 Access Release Notes and White Papers Pages

In this exercise, you access release notes and white paper pages. In 
part I, you access the HTML version of the release notes. In part II, 
you install the HTML howtos. In part III, you access the howto of 
the DSL configuration.

Do the following:

■ Part I: Access Release Notes

■ Part II: Install Howtos

■ Part III: Access Howtos

Part I: Access Release Notes

To access release notes, do the following:

1. Start the file manager Nautilus by selecting the geeko’s Home on 
the desktop.

2. Double-click the File System icon.

3. Double-click the usr icon.

4. Double-click the share icon.

5. Double-click the doc icon.

6. Double-click the release-notes icon.

7. Double-click the SUSE_Linux_Enterprise_Server_10 icon.

8. Double-click the RELEASE-NOTES.en.html icon.

The Firefox web browser starts.

9. Read the Release Notes by selecting 
RELEASE-NOTES.en.html in the web browser.

10. Close the Firefox window.

11. Close the Nautilus window.
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Part II: Install Howtos

To install howtos, do the following:

1. From the GNOME desktop, open the main menu.

2. Select More Applications.

3. Enter ya into the Filter text box.

4. Select the YaST icon to start YaST.

5. Enter the root password novell in the appearing dialog; then 
select Continue or press Enter.

6. The YaST Control Center appears.

7. From the YaST Control Center, select Software > Software 
Management.

8. From the Filter drop-down list, select Search.

9. In the Search textbox enter howto; select Search.

10. From the right side of the window, select the package howtoenh.

11. Select Accept.

12. (Conditional) If requested by YaST, insert the appropriate SUSE 
Linux Enterprise Server 10 DVD; then select OK.

13. When asked to install or remove more packages, select No.

14. Close the YaST Control Center by selecting Close.

15. (Conditional) If you installed from DVD, remove the DVD from 
your drive.

Part III: Access Howtos

To access howtos, do the following:

1. Start the file manager Nautilus by selecting the geeko’s Home on 
the desktop.

2. Double-click the File System icon.

3. Double-click the usr icon.
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4. Double-click the share icon.

5. Double-click the doc icon.

6. Double-click the howto icon.

7. Double-click the html icon.

8. Double-click the DSL-HOWTO icon.

9. Double-click the index.html icon.

The Firefox web browser starts.

10. Close the Firefox window.

11. Close the Nautilus window.

(End of Exercise)
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Exercise 4-4 Find Help on the Web

In this exercise, you learn how to find help on the web. You look 
for updates for SUSE Linux Enterprise Server 10 on the Novell 
support website. In part II, you use the Google Linux search engine 
to find information on GNOME and SLES10 in the internet.

Do the following:

■ Part I: Start Firefox

■ Part II: Look for Patches at the Novell Website

■ Part III: Use Google to Find Information

Part I: Start Firefox

To start Firefox, do the following:

1. Start Firefox by selecting the Firefox icon on the desktop.

Part II: Look for Patches at the Novell Website

To look for patches at the Novell website, do the following:

1. In the Location bar enter support.novell.com.

The Novell support home page appears.

2. Select download > patches in the left column.

3. Select SUSE Patch Support Database (PSDB).

4. Select by product.

5. Select SUSE Linux Enterprise Server 10 for x86 (i386).

You get a list of patches. You must have a registered SUSE 
product with upgrade protection in order to access the patch 
downloads.
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Part III: Use Google to Find Information

To use Google to find information, do the following:

1. When you finish, in the address field enter
www.google.com/linux

2. In the text field at the top of the page, enter
gnome and sles10

3. Select Google Search.

4. Select one or more of the displayed links.

5. When you finish, close the Firefox window.

(End of Exercise)
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S E C T I O N 6 Work with the Linux Shell and 
Command Line

In this section of the workbook, you learn how to do the following:

■ “Execute Commands at the Command Line” on 6-2

In this exercise, you use the history feature of the shell and get 
root permissions at the command line. You use the commands 
history and su. 

■ “Perform Common Command Line Tasks” on 6-3

In this exercise, you create an alias labeled “hello” that prints a 
personal welcome message “Hello username” on the screen.

■ “Work with Command Syntax and Special Characters” on 6-4

In this exercise, you learn how to use wildcards and other 
special characters. 

■ “Use Piping and Redirection” on 6-7

In this exercise, you practice piping the output of standard 
comands into files and other commands. 
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Exercise 6-1 Execute Commands at the Command Line

In this exercise, you use the history feature of the shell and get root 
permissions at the command line. You use the commands history 
and su. 

To execute commands at the command line, do the following:

1. Open a terminal window.

2. View the history cache by entering
history

3. Press Up-arrow until you see an ls command you would like to 
execute; then press Enter.

4. Type h and press Page Up once.

You should see the command history at the command line 
again.

5. Press Enter to execute the history command.

6. Switch to root by entering su –; then enter a password of novell.

7. Check to make sure you are logged in as root by entering
id

8. Start YaST by entering
yast2

YaST should start in QT mode.

9. Quit YaST by selecting File > Quit.

10. Become the user geeko again by entering
exit

11. Close the terminal window by entering
exit

(End of Exercise)
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Exercise 6-2 Perform Common Command Line Tasks

In this exercise, you create an alias labeled “hello” that prints a 
personal welcome message “Hello username” on the screen. At the 
end of this exercise, you remove this alias.

To understand common command line tasks, do the following:

1. Open a terminal window.

2. View all defined aliases by entering
alias

3. Define a new alias by entering the following
alias hello='echo Hello $USER'

4. Check the functionality of the alias hello by entering
hello

5. Check the command type of the command hello by entering
type hello

6. Remove the alias by entering
unalias hello

7. Close the terminal window.

(End of Exercise)
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Exercise 6-3 Work with Command Syntax and Special Characters

In this exercise, you learn how to use wildcards and other special 
characters. 

To learn how to use command syntax and special characters, do the 
following:

■ Part I: Change the Character Encoding

■ Part II: Use Search Patterns

■ Part III: Create Some More Files

■ Part IV: Mask Special Characters

Part I: Change the Character Encoding

To change the character encoding, do the following:

1. Open a terminal window.

2. To change the character encoding from UTF-8 to POSIX, enter
LANG=POSIX

Part II: Use Search Patterns

To use search patterns, do the following:

1. List all filenames in the directory /bin/ that start with the 
character “a” by entering
ls /bin/a*

2. List all file names in the directory /bin/ that consist of 4 
characters by entering
ls /bin/????

3. List all filenames in the directory /bin/ that consist of 4 or more 
characters by entering
ls /bin/????*
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4. List all filenames in the directory /bin/ that do not start with one 
of the characters from a to r by entering
ls /bin/[!a-r]*

Part III: Create Some More Files

To create some more files, do the following:

1. Start the file manager Nautilus by selecting geeko’s Home at the 
desktop.

2. Create a new file by right-clicking the file view frame and 
selecting Create Document > Empty File.

3. Enter a filename of My; then press Enter.

4. Create a new file by right-clicking the file view frame and 
selecting Create Document > Empty File.

5. Enter a filename of File; then press Enter.

6. Create a new file by right-clicking the file view window and 
selecting Create Document > Empty File.

7. Enter a filename of My File; then press Enter.

8. Close the Nautilus window.

Part IV: Mask Special Characters

To mask special characters, do the following:

1. From the terminal window, list the files My and File by entering
ls -l My File

2. List the file My File by entering
ls -l My\ File

3. Remove the files My, File, and My File by entering
rm My File My\ File

4. Verify that the files have been removed by entering
ls -l
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5. Close the terminal window.

(End of Exercise)
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Exercise 6-4 Use Piping and Redirection

In this exercise, you practice piping the output of standard comands 
into files and other commands. 

To understand piping and redirection, do the following:

1. Open a terminal window.

2. Pipe the output of the ls command for the home directory (“~”) 
to a file by entering
ls ~ > home_directory

3. Display the content of the file by entering
cat home_directory

4. Append the output of the ls command for the root directory (“/”) 
to the file home_directory by entering
ls / >> home_directory

5. Display the content of the file by entering
cat home_directory

6. Overwrite the file home_directory with the output of the ls 
command by entering
ls / > home_directory

7. Display the content of the file by entering 
cat home_directory

8. Write the output of the ls command on the screen and into the file 
home_directory by entering
ls ~ | tee home_directory

9. Remove the file home_directory by entering
rm home_directory

10. Verify that the file was removed by entering
ls -l

11. Close the terminal window.

(End of Exercise)
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S E C T I O N 7 Use Linux Text Editors

In this section of the workbook, you learn how to do the following:

■ “Use vi to Edit Files in the Linux System” on 7-2

In this exercise, you create an edit a file with the text editor vi.
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Exercise 7-1 Use vi to Edit Files in the Linux System

In this exercise, you create a new file vi_test with the text editor vi. 
In part II, you edit the text in the command mode of vi.

To use the command line editor vi, do the following:

■ Part I: Enter a Text

■ Part II: Edit a Text

Part I: Enter a Text

To enter a text, do the following:

1. Open a terminal window.

2. Start vi by entering vi.

3. Switch to the insert mode by typing i.

4. Type the following two paragraphs of text (press Enter at the end 
of each line):

Administrator training for SUSE Linux Enterprise Server 
10 will be held
in Training Room 4 of Building B on Tuesday
of next week.

Make sure you bring your SUSE Linux Enterprise Server 
10 Administration
Manual. There will be wireless Internet access
available in the training room.

5. Exit the insert mode by pressing Esc.

Part II: Edit a Text

To edit a text, do the following:

1. Move the cursor to the middle of the second line of the first 
paragraph.

2. Delete text to the right of the cursor by typing D (uppercase d).
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3. Undo the deletion by typing u.

4. Delete the character directly under the cursor by pressing Delete.

5. Copy the current line to the internal buffer by typing y twice.

6. Move the cursor to the beginning the first line of the second 
paragraph.

7. Insert the contents of the internal buffer after the current line by 
typing p.

8. Save the file with filename vi_test by entering :w vi_test.

9. Exit vi by entering :q.

10. Close the terminal window.

(End of Exercise)
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S E C T I O N 8 Manage Users, Groups, and 
Permissions

In this section of the workbook, you learn how to do the following:

■ “Manage User Accounts with YaST” on 8-2

In this exercise, you create and remove an user account with the 
YaST user management module. 

■ “Check User and Group Information on Your Server” on 8-5

In this exercise, you write down the GIDs of some groups and 
the UIDs of some users. You also switch to user root with the 
su command.

■ “Create and Manage Users and Groups from the Command 
Line” on 8-7

In this exercise, you add and remove an user from the command 
line.

■ “Manage File Permissions and Ownership” on 8-10

In this exercise, you create directories with different 
permissions. 
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Exercise 8-1 Manage User Accounts with YaST

In this exercise, you create and remove a user account with the 
YaST user management module. In part I, you create a new account 
labeled “tux” for the user “Tux Penguin” with the password of 
“novell”. In part II, you log in as user tux. In part III, you open the 
file /etc/passwd and look for the entries for geeko and tux. In part 
IV, you log in as geeko and remove tux’s account.

To manage user accounts with YaST, do the following:

■ Part I: Create a New User Account with YaST

■ Part II: Log In as New User

■ Part III: View the passwd File

■ Part IV: Log In as User geeko and Remove the New User 
Account

Part I: Create a New User Account with YaST

To create a new user account with YaST, do the following:

1. From the GNOME desktop, select Applications > System > 
YaST; then enter a password of novell and select Continue.

The YaST Control Center appears.

2. From the YaST Control Center, select Security and Users > 
User Management.

3. Add a new user by selecting Add.

4. Enter the following information:

❑ User’s Full Name: Tux Penguin

❑ Username: tux

❑ Password: novell

❑ Confirm Password: novell

5. When you finish, select Accept.

6. Confirm the password warning by selecting Yes.
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7. Save the new settings by selecting Finish.

8. Close the YaST window.

Part II: Log In as New User

To log in as the new user, do the following:

1. From the bottom panel, log out by selecting Desktop > Log Out.

2. In the log out dialog, select OK.

X Window is restarted and the GUI login screen appears.

3. In the Username field enter tux and press Enter.

4. In the Password field enter novell and press Enter.

5. Close or cancel any displayed dialogs.

Part III: View the passwd File

To view the passwd file, do the following:

1. Start the Nautilus file manager by double-clicking the tux’s 
Home icon on the desktop.

The content of tux’s home directory is displayed.

2. Browse to the directory /home.

Notice there are directories for users tux and geeko.

3. Browse to the directory /etc.

4. Select the file passwd.

Notice the entries for users tux and geeko at the end of the file.

5. Close all windows.
Version 1 Copying all or part of this manual, or distributing such copies, is strictly prohibited.  WB 8-3
To report suspected copying, please call 1-800-PIRATES.

ONLINE VIEW ONLY-NO PRINTING OR DISTRIBUTION ALLOWED



SUSE Linux Enterprise Server 10 Fundamentals / Workbook 
Part IV: Log In as User geeko and Remove the New User 
Account

To log in as user geeko and remove the new user account, do the 
following:

1. From the bottom panel, log out by selecting Desktop > Log Out.

2. In the log out dialog, select OK.

X Window is restarted and the GUI login screen appears.

3. Log in as geeko with a password of novell.

4. Start YaST by selecting Applications > System > YaST; then 
enter a password of novell and select Continue.

5. From the YaST Control Center, select Security and Users > 
User Management.

6. From the list of users, select tux; then select Delete.

7. Select Delete Home Directory /home/tux; then select Yes.

8. Select Finish.

9. Confirm that the user tux has been removed by doing the 
following:

a. Start the Nautilus file manager by double-clicking the 
geeko’s Home icon on the desktop.

The content of Geeko’s home directory is displayed.

b. Browse to the directory /home.

Notice there is only one entry for user geeko.

c. Browse to the directory /etc.

d. Select the file passwd.

Notice the entry for tux has been removed from the end of 
the file.

e. Close the Nautilus window.

10. Close the YaST Control Center.

(End of Exercise)
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Exercise 8-2 Check User and Group Information on Your Server

In this exercise, you write down the GIDs of some groups and the 
UIDs of some users. You also switch to user root with the su 
command.

Check the user and group information on your SUSE Linux 
Enterprise Server by doing the following from a command line:

1. Make sure you are logged in as geeko to the GNOME desktop.

2. Start a terminal emulation from the main menu.

3. Switch to user root by entering su - with a password of novell.

4. Display all information in the file /etc/group by entering
less /etc/group.

5. Write down the GIDs of the following groups:

a. ftp

b. lp

c. nobody

d. root

e. www

f. users

6. Exit by typing q.

7. Display the contents of the file /etc/passwd by entering
less  /etc/passwd.

8. Write down the UIDs of the following groups:

a. ftp
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b. lp

c. nobody

d. root

e. wwwrun

f. geeko

9. Exit by typing q.

10. Display the identity information of the logged in user by entering 
id.

Because you have root permissions, you see UID, GID, and 
group information for root.

11. Exit the su state and return to the geeko user by entering exit.

12. Enter id again.

Notice that the groups displayed for geeko are different from 
those displayed for root.

13. Close the terminal window by entering exit.

(End of Exercise)
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Exercise 8-3 Create and Manage Users and Groups from the Command 
Line

In this exercise, you add and remove an user from the command 
line. In part I, you add a new user account labeled “tux” for user 
“Tux Penguin” with the useradd command. You also look for the 
new entries in the files /etc/passwd and /etc/shadow. In part II, you 
set the password for tux to “novell” with the command passwd. In 
part III, you switch to user tux with the command su and to change 
the password to “d1g1t@l” with the command passwd. In part IV, 
you remove the account of user tux with the command userdel. You 
also change a password. 

To manage user accounts, do the following:

■ Part I: Add a New User

■ Part II: Create a Password for the New User

■ Part III: Log In as New User and Change Your Password

■ Part IV: Remove the New User Account

Part I: Add a New User

To add a new user, do the following:

1. Open a terminal window; then switch to root (su -) with a 
password of novell.

2. Create a new local user by entering the following
useradd  -c  “Tux Penguin”  -m  tux

3. Verify that a home directory for tux was created by entering
ls  /home

4. Verify that there is a entry for the tux user in /etc/passwd by 
entering
cat  /etc/passwd.

Notice the “x” in the second field, indicating that the password 
for tux is stored in /etc/shadow.
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5. Have a look at the password in /etc/passwd by entering
cat  /etc/shadow.

Notice the “!” in the second field, indicating that there is no 
valid password for tux.

Part II: Create a Password for the New User

To create a password for the new user, do the following:

1. Create a password for the user tux by entering
passwd  tux.

2. Enter the password suse twice.

3. Log out as root by entering
exit

Part III: Log In as New User and Change Your Password

To log in as the new user and change your password, do the 
following:

1. Log in as tux by entering
su  -  tux

2. Enter the tux password (suse).

3. Change the password of the user tux by entering
passwd

4. Enter the old password of the user tux (suse).

5. Try to change the password to novell by entering
novell

You receive a warning that the password is too simple.

6. Enter d1g1t@l as new password (twice).

7. Log out as user tux by entering
exit
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Part IV: Remove the New User Account

To remove the new user account, do the following:

1. Switch to user root (su -) with a password of novell.

2. Delete the user tux by entering
userdel  -r  tux

3. Verify that the home directory for tux has been removed by 
entering
ls /home

4. Verify that there is no entry for tux in /etc/passwd by entering
cat  /etc/passwd

5. Close the terminal window.

(End of Exercise)
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Exercise 8-4 Manage File Permissions and Ownership

In this exercise, you create directories with different permissions. 

In part I, you create a directory ~/files/ with two subdirectories 
private/ and public/. You change the permissions for the directory 
private/ that only root has read, write, and execute permissions and 
the permissions of public/ that everyone has rights to the directory.

In part II, you switch to user geeko. You try to create a file “geeko” 
inside each of these directories. For the file ~/public/geeko, you 
have to change the permissions that the users group has write 
permissions and other does not have any permissions.

To manage file permissions and ownership, do the following:

■ Part I: Create a Private and a Public Directory

■ Part II: Try to Create a File as a Normal User in Both 
Directories

Part I: Create a Private and a Public Directory

To create a private and a public directory, do the following:

1. Open a terminal window, and switch to root (su -) with a 
password of novell.

2. Create the directory /files/ by entering
mkdir /files

3. Change to the directory /files/ by entering
cd /files

4. To create the subdirectories private and public under /files/ enter
mkdir  private  public

5. Change the permissions on the private directory so that only root 
has read, write, and execute permissions by entering the 
following
chmod  700 private
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6. Change permissions on the public directory so that everyone has 
rights to the directory by entering the following
chmod  777  public

7. Verify the changes by entering
ls -l

Part II: Try to Create a File as a Normal User in Both 
Directories

To try to create a file as a normal user in both directories, do the 
following:

1. Switch to virtual terminal 3 by pressing Ctrl+Alt+F3.

2. Login as geeko with a novell password.

3. Switch to the directory /files/ by entering
cd  /files

4. Try to create a file named geeko in the private directory by 
entering
touch  private/geeko

Notice that permission is denied.

5. Try to create a file named geeko in the public directory by 
entering
touch  public/geeko

6. Verify that the file is created by entering
ls  public

7. Change to the public directory by entering
cd  public

8. List the permissions of the file geeko by entering
ls  -l  geeko

Notice that the group users and other have only read permission 
for the file.
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9. Change permissions so that the group users has write 
permissions and other does not have any permissions by entering 
the following
chmod  g+w,o-r  geeko

10. Verify the change by entering
ls -l

11. Log out as geeko by entering exit (or by pressing Ctrl+D); then 
return to the GNOME Desktop (Ctrl+Alt+F7).

12. Close the terminal window.

(End of Exercise)
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A P P E N D I X  A Use the KDE Desktop Environment

In this section of the workbook, you learn how to do the following:

■ “Install the KDE Desktop Environment” on A-2

In this exercise, you install the KDE desktop environment 
parallel to GNOME. You also log out from the GNOME 
environment.

■ “Explore Your KDE Desktop” on A-3

In this exercise, you explore your KDE desktop.
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Exercise A-1 Install the KDE Desktop Environment

In this exercise, you install the KDE desktop environment parallel 
to GNOME. You also log out from the GNOME environment.

Do the following from the GNOME desktop:

1. Start YaST from the main menu.

2. Enter novell as root password and select Continue.

3. Select Software Management.

4. Select Patterns from the Filter pull-down menu.

5. Select KDE Desktop Environment in the left frame; then select 
Accept.

6. Confirm the information dialog, about automatically resolved 
dependencies by selecting Continue.

7. Insert the installation media YaST asks for and select OK.

8. When asked to change the installation media, change it and select 
OK.

9. When finished and asked to install or remove more packages, 
select No.

10. Close the YaST window.

11. Select Desktop > Log Out to log out from GNOME.

12. In the confirmation dialog make sure that Log out is selected and 
select OK.

(End of Exercise)
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Exercise A-2 Explore Your KDE Desktop

In this exercise, you explore your KDE desktop. In part I, you log in 
to the KDE environment. In part II, you use Konqueror to copy the 
file /etc/DIR_COLORS into your home directory. In part III, you 
rename the copied file to “example.txt”. In part IV, you log out 
from the KDE desktop.

Do the following from the GUI login screen:

■ Part I: Log In to the KDE Desktop Environment

■ Part II: Copy a File with Konqueror

■ Part III: Rename a File

■ Part IV: Log Out

Part I: Log In to the KDE Desktop Environment

To log in to the KDE desktop environment, do the following:

1. Select Session.

2. Select KDE; then select OK.

3. In the Username field, enter geeko and press Enter. 

4. In the Password field, enter novell and press Enter.

5. Select Just For This Session.

The KDE desktop environment starts and initial dialogs appear.

Part II: Copy a File with Konqueror

To copy a file with Konqueror, do the following:

1. Start the file manager Konqueror by selecting the house icon in 
Kicker.

2. To view the root directory in the navigation panel, select the red 
folder icon at the left of the navigation panel.
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3. View the contents of the /etc directory by selecting etc in the 
navigation panel (a single mouse click).

4. Copy the file /etc/DIR_COLORS to the directory /tmp/ by 
scrolling down and selecting the DIR_COLORS file icon, 
dragging it over the tmp folder icon in the navigation area, and 
releasing the mouse button.

5. From the popup menu, select Copy Here.

6. View the contents of the directory /tmp by selecting tmp in the 
side panel (a single mouse click).

Part III: Rename a File

To rename a file, do the following:

1. Rename the copied file by right-clicking the DIR_COLORS file 
icon and then selecting Rename from the popup menu.

2. For the new filename, type example.txt; then press Enter.

3. Quit Konqueror by selecting the X button in the top right corner 
of the window.

Part IV: Log Out

To log out, do the following:

1. Open the KDE menu by selecting the leftmost icon in the bottom 
panel. 

2. Select Log Out; then select End Current Session.

You are returned to the GUI login screen.

(End of Exercise)
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